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Fusion 360 Drawings allows you to create 2D drawings from your Fusion 360 designs, which provides the
ability to generate PDF and DWG documentation of your Fusion 360 model. When you create a drawing,
it is generated as a derived document of a Fusion 360 model, and it shows up in the Data Panel as a
unique item in the active project.

Lesson 1: Introduction to Drawing Views

Learning Objectives

1. What are Drawing Views?
2. Initiate a New Drawing

3. Place a Base View

A drawing view is an object that contains a 2D projection of a 3D model.

When you create a drawing from the Fusion 360 modeling environment, the system automatically
launches a new tab of the Drawing workspace and generates a 2D projection of the components you
select. The drawing view generated is referred to as a base view. Once you place the base view in the
drawing, you can generate orthogonal and isometric projected views from it. A projected view takes the
characteristics of a base view and projects it from a different angle.



About the Marking Menu

The marking menu is a radial display of the most frequently used commands. It also includes an
overflow menu that provides quick access to all commands found in the toolbar.

Using the marking menu can be the fastest way to input a command in any workspace. You can
access the marking menu by right-clicking anywhere within the drawing canvas.

’: 4= Repeat Undo ‘

o - ro
Move € | | BB Projected View |

As you move the cursor from the center of the marking menu towards a command, its wedge
highlights. Clicking anywhere in the wedge launches the command.

Datasets Required
In Samples section of your Data Panel, browse to:

Fusion 101 Training > 08 — Drawing > 08_Drawings Utility Knife

Open the design and follow the step-by-step guide below to get started with the lesson.



Create a Drawing

g "_-E v M v ReadOnly
New Design wing v21*
=° New Drawing from Design ]
_ [ Related Data » W
= Open Details in A360 ¥v  ASSE
« B Sae Ctr+s B
4 Save as =
Step 1: — Save the model Bt N
- 3D Print
1. If the modelis “Read Only,” go to the | Captureimage
. . View »
File Menu and click Save As. Scripts and Add-ns =
2. Give the model a location and a new e Sl —
name, then click Save. =D fRCRCostucion
D @ (@ Right1
D 9 (@ Lemt
D @ (O Grpt1
B H v~
P U newDesign
New Drawing from Design
" Related Data > m o—:)
. X X Open Details in A360 v ASSEMBLE v SKETCHY
Step 2: — Initiate a New Drawing — With the B S cms by
ope o . . Save as
Utility Knife design open, do the following: A — o
Share >
. . 3D Prin
1. Click on the File dropdown menu from o e
View >

the top menu bar.
2. Select New Drawing from Design
from the file menu dropdown.

Add-Ins (Legacy).

Scripts and Add-Ins....

Step 3: — Choose Assembly

1. Select “Full Assembly” from the dialog
and click OK to initiate the drawing.

2. Notice that a new file tab is
automatically generated.

Note: If you un-check “Full Assembly” from
the New Drawing dialog, you can select
individual or multiple components to create a
drawing of part of the assembly.

Tip: When selecting multiple components, it
helps to use Ctrl+click.

~|® NEW DRAWING FROM DESIGN = —

Full Assembly

Sheet Size

%

Drawing Format ASME

Units in

OK
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Cancel




You can set the drawing format, units, and
sheet size before you create a drawing.
However, Drawing Format and Units cannot
be changed once you create a new drawing.

Step 4: — Commit a Base View

1. Move your cursor around the screen.
Notice that the Base View preview is
attached to the cursor.

2. Click on the top left quadrant of the
sheet to place the view.

3. Click OK to commit the view.

Note: Notice that after the view is committed,
the shaded preview matures into a 2D line
drawing of the view.

© VIEW PROPERTIES

Orientation @ Front v

Scale 12 v

v Edge Visibility

Hidden Lines off v

Tangent Edges Off v

Interference Edges  On 3
OK Cancel




Lesson 2: Projected Views and Detail Views

Learning Objectives
1. Create Projected Views
2. Edit View Properties

3. Create Detail Views

Add to the Layout

Step 1: — Initiate Projected View — Now that
you we’ve created a base view of the model
assembly, let’s create projected views and edit
their properties to create a complete drawing
layout.
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b Utility Knife v10

x | K utility ...ing v18*
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| BE%. © &

MODIFY ¥

1.

From the View Toolbar, select

Projected View.

2. Click the base view to select it as the
parent view from which the projected
views will be created from and
associated.

A /A

ANNOTATION ¥

Step 2: — Place the views

1. Drag the cursor to the right of the
base view, and notice that the
projected view is previewed based on
this alignment.

2. Select to the right of the existing base
view to place a projected view.

3. Select to the bottom of the existing
base view to place a second projected
view.

4. Press Enter to finish the task.

Note: A projected view inherits all its
properties from the parent. When the
properties of the parent view change, the
corresponding properties on the projected
view also change. You can change the
properties of a projected view by double-
clicking it.

Specify location of projected view




Step 3: — Create an Isometric Base View

1.

w

From the View Toolbar, select Base
View.

Click to place the view in the lower

right of the sheet layout, above the
title block.

Set the Orientation to NE Isometric.
Press OK to commit the view.

VIEWS ¥

=
Base View

MODIFY ¥

Generates a base view of the model.

Specify the location of the base view and

modify its properties.

||\E B & HAMA

ANNOTATION ¥
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Orientation

Scale

Hidden Lines

Tangent Edges

v Edge Visibility

Interference Edges

q
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About Projected Views & View Options

Projected views maintain a parent-child relationship with the base view it was generated from.
They inherit their properties from the parent base view. If necessary, you can override them after you
create the projected view.

The projection angle defines the method employed to generate projected views.

first angle

third angle




First Angle Projection — When you use first angle projection, projected views placed to the right of a
base view depict the appearance when viewing it from the left. Projected views placed below the base
view depict the appearance from above. The ISO drafting standard specifies that drawings use first angle
projection. By default, when the drawing format is set to ISO, the Drawings workspace will use first
angle projection.

Third Angle Projection — When you use third angle projection, projected views placed to the right of a
base view depict the appearance when viewing it from the right. Projected views placed below the base
view depict the appearance from below. The ASME drafting standard specifies that drawings use third
angle projection. By default, when the drawing format is set to ASME, the Drawings workspace will
use third angle projection.

Edit the Layout Views

Step 1: — Edit the isometric base view - Now
that you have created a base view and several
projected views of the model, let’s use the e . .
View Properties settings to further customize v Edge Visibility

the view layouts. sEEls | v

Tangent Edges Off v

© VIEW PROPERTIES

Interference Edges  On v

1. Double-click anywhere inside the
selection boundary of the isometric
view to activate it.

2. Select the Scale ratio in the View

Properties dialog box to scale the base

view.

Change the Scale to: 1:1.

4. Click Close to accept the drawing view
changes.

w




Step 2: — Edit the right projected view

1. Double-click anywhere inside the
selection boundary of the right
projected view to activate it. .

2. Inthe View Properties dialog box, edit ' o VIEW PROPERTIES
the properties of the component. et 12

3. For Hidden Lines, select On from the e sy
drop-down list.. Tangent Edges  OF .

4. Click Close to accept the drawing view Intererence Edge.. On v
changes.

Hidden Lines On A

Close

Note: Once the projected view properties are
changed, they no longer inherit the settings of
the base view. If you change the properties
back to “From parent,” they will once again
inherit properties from the parent view.

© VIEW PROPERTIES

Scale 1:2 (From pare...v

Step 3: — Edit the bottom projected view

¥ Edge Visibility

1. Double-click anywhere inside the Hidden Lines | OMGIonYpetolg
selection boundary of the bottom
projected view to activate it.

2. Inthe View Properties dialog box, edit
the properties of the component.

3. For Tangent Edges, select Full Length
from the drop-down list.

4. Click Close to accept the drawing view

changes.

Tangent Edges  FullLength v

Interference Edge... On v

Close

View Properties

Hidden Lines — Select On or Off from the drop-down list to display hidden lines within the
selected base view. The Hidden-line representation suppresses or exposes lines, edges and other objects
that are located behind other three-dimensional objects. This view property can be particularly helpful
when trying to visually communicate the inner workings or dimensions of a complex assembly or part.



Hidden Lines OFF Hidden Lines ON

Tangent Edges — Select Full length, Shortened or Off from the drop-down list to display Tangent edges
within the selected base view. Tangent edges mark the transition between a flat surface and a rounded
edge, most commonly seen as filleted edges. Tangent edges can be set to Full Length, Shortened, or Off.

P

Tangent Edges Off Tangent Edges Shortened Tangent Edges Full Length

Interference Edges — Select On or Off from the drop-down list to display of Interference edges within
the selected base view. An interference edge occurs when two faces of two components

intersect. When Interference Edges are turned on, an edge is displayed that shows where the two
components meet. When selected, associated drawing views are to display both hidden and visible
edges that were previously excluded due to an interference condition (press, or interference fit
conditions, threaded fasteners in tapped holes where the hole feature is modeled with the minor
diameter).

OSE

Interference Edges Off Interference Edges ON

10



Create a Detail View

A detail view is a projected view that shows a specific portion of a view at an enlarged scale.

Step 1: — Create a Detail View

1. Select Detail View in the View

Toolbar.

2. Select the right side view as a parent
view.

3. Click the center point for the detail
boundary.

4. Click again to specify the size and
location of the detail boundary, and
then click to place the detail view.

5. Change the Scale of the detail view to
2:1, then press OK to generate the
detail view.

Move Objects

Click anywhere on an object to select it, click
the gray grip in the center of the object, then
click a new location for the object.

Note: The Move action works the same way
for all views, text objects, dimensions, and
balloons.

Move your objects around your drawing so they are nicely spaced, leaving the top right of the drawing
space open (for a Parts List, to be added later).

By now, your drawing should look something like this:

11
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Lesson 3: Text and Leader Notes

Learning Objectives

1. Create Text

2. Create Leader Notes

3. Reposition Annotation and Edit Text

Adding Text and Leaders

e HEl~A 8o & Il

MODIFY ¥ ANNOTATION v BOM~¥ OUTPUT ¥

L Text

Specify the corners for the text box, and then
enter text. When finished, click outside the

text editor.

Ui

-l

Step 1: — Create Text

1. |Initiate Text from the toolbar.
2. Select two corners below the Front

View to create a text box. =52
3. Type the following text into the text _\\\

box: “Front View”.
4. Select anywhere outside of the text

box to commit the action. Aﬁ
5. Repeat the process to add text below

the to the other views, naming them _

“Bottom View,” “Right View,” and “NE iy
Isometric View”.

Specify opposite corner




Step 2:

— Create Leader Notes

Initiate Leader Note from the toolbar.
Click the blade of the bottom view to
place the start of the leader.

Click outside the view to place the end
of the leader.

Type the following text: “Steel blade.”
Select anywhere outside of the text
box to commit the action.

Tip: When selecting a part of an object, you'll

see green shapes on the object. These are
called Object Snap points, and they help you

specify

a precise point on the object, like an

endpoint, a midpoint, or a center point.

&

MODIFY ¥

HAl 2L @

ANNOTATION ¥ BOM~¥ OUTPUT ¥

Leader

Specify the arrowhead location, specify the
location of the text, and then enter text.

When finished, click outside the text editor.

Front View

Step 3: — Reposition Leader Notes / Steel Blade
1. Click on the leader note to activate it.
2. Click any of the gray grips to move the
leader note to a new location.
3. Click anywhere outside the leader
note to commit the action.
Step 4: — Edit Text
1. Double-click on the leader note to
activate the text editor
2. Dragthe <> to the right to format the
text into 2 lines.
3. Click anywhere outside of the text box

to commit the action.

14



Lesson 4: Dimensions

Learning Objectives
1. Create Linear, Aligned, Angular, Radial, and Diameter Dimensions
2. Reposition Dimensions
3. Use the Baseline and Chain Dimensioning tools

Create Dimensions

1+ -
NN
MODIFY ¥ ANNOTATION ¥ BOM~¥ OUTPUT~

Linear Dimension

Creates a horizontal or vertical linear
dimension.

Specify two points, and then place the
dimension. Alternatively, press Spacebar,
select an edge, and then place the dimension.

Step 1: — Create a Linear Dimension

1. Initiate Linear Dimension.

2. Use Object Snaps to click the two
endpoints of the bottom view. A
preview is displayed on your curser.

3. Dragthe cursor out to the right

4, Click again to place the dimension and ’
complete the action.

Note: You can also press Spacebar and then 2
select an edge to create a dimension with only

one click. J
Specify second extension line

15
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Step 2: — Create an Aligned Dimension

1. Initiate Aligned Dimension.

2. Using Object Snaps, click the top edge
and bottom point of the cutting blade
on the right view.

3. Dragthe cursor out to the left to see a
preview of the dimension.

4. Click again to place the dimension and
finish the action.

Note: Linear dimensions measure the
horizontal or vertical distance between two
points. Aligned dimensions measure the true
distance between two points.

4, Aligned Dimension
Angular Dimension

®© Radial Dimension
® Diameter Dimension
[ Baseline Dimension
11 Chain Dimension

A Text

/A Leader

Creates an aligned finear dimension.

Specify two points, and then place the
dimension. Alternatively, press Spacebar,

select an edge, and then place the dimension.|

16
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Step 3: — Reposition the Dimension

1.

Click the aligned dimension.

Click the gray grip on the text.

Move the text so it is between the
dimension arrows.

Click anywhere outside the dimension
to complete the action.

Midpoint

Step 4: — Create a Radial Dimension

Initiate Radial Dimension.

Select the curved end of the handle in
the right side view.

Drag the cursor down and to the right
to see a preview of the dimension.
Click again to place the dimension and
complete the action.

R0.62in

Specify dimension line location

17



Step 5: — Create a Diameter Dimension

Initiate Diameter Dimension.

Select the blade slider on the detail
view.
3. Dragthe cursor up and to the right
and see a preview of the dimension.
4. Click again to place the dimension and
finish the action.

0.24in

Specify dimension line location

Step 6: — Create an Angular Dimension

1. Initiate Angular Dimension.

2. Click the side of the knife in the Front
View.

3. Dragthe cursor to the left to see a
preview of the dimension.

4. Click again to place the dimension and
finish the action.

Use Chain and Baseline Dimensions

Front View

The Baseline Dimension tool creates multiple linear dimensions measured from the same location. The
Chain Dimension tool creates multiple linear dimensions placed end to end.

Baseline and chain dimensions derive from an original dimension. You must first create a linear

dimension before you create baseline or chain dimensions.

Step 1: — Create a new Linear Dimension

1. Let’s delete the Linear Dimension on
the bottom view by selecting the
dimension, then pressing the Delete

18



key, or by selecting Delete in the

Marking Menu.
2. Create a new linear dimension at the

end of the blade cradle.

0.5Pin

J f

Step 2: — Place Chain Dimensions

1. Select Chain Dimension in the
Annotation toolbar.

2. Select the lower extension line of the
newly placed dimension.

© Radial Dimension

@® Diameter Dimension

[ Baseline Dimension

It1Chain Dimension
A Text Continues creating linear dime]

18.2°

/A Leader Select an existing finear dimen

5/ specify a point to create a ney|
Continue specifying points to (
dimensions. Each new dimensid

Front View automatically.

Steel

- 0.59in

Select base dimension

19



Step 3: — Complete the Chain Dimension

1. Click the end of the knife’s grip to
specify the endpoint of the first
dimension.

2. Click again to specify another
endpoint of a dimension.

3. Click once more at the very end of
the bottom view.

4. To finish the action, press Enter.

Endpoint

\

)

0.59in

1.94in

3.03in

Bottom View

Baseline Dimensions work the same way as Chain Dimensions, only they create multiple dimensions that

all begin from the same location. If you were to use Baseline Dimensions here, it would look like this:

20
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By now, your drawing should look something like this:
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Modify the Properties of an Individual Dimension, and add Tolerance and
Representation.

‘ © DIMENSION PROPERTIES
. Primary Precision  0.12 v
3_03|n Alternate Units D
¥ Tolerance
Type X None v
» Representation
Step 1: — Access Dimension Properties » Inspection
1. Double-click the dimension on the ’ Slose
back grip of the bottom view. s
<
<0.46in>
The Dimension Properties dialog box opens.
\'A
© DIMENSION PROPERTIES
Primary Precision ~ 0.123 4
. . . ; . Alternate Units @
Step 2: — Modify the dimension’s properties Atomats Prcicion B 8
. . . » Tolerance
1. Change the primary precision for this -<8'2§§in>[[ﬁ'°5§]mml b Representation
dimensionto 0.123. | [BEEiiReed >
2. Have the dimension display Alternate T
Units.
©® DIMENSION PROPERTIES
Primary Precision 0.123 v
Alternate Units
Alternate Precision  0.12 v
Step 3: — Add tolerance to the dimension ¥ Tolerance
Type H Limit v
1. Under Tolerance, select Limit, and . Upper Tolerance 0,01 .
. — 'gg'm[ [ﬁgs L) | 001 .
give it an Upper and Lower tolerance oo AERS o B oreridemes 1
» Representation
of 0.01. N
2. Press Close.
Close




Step 4: — Create a reference dimension

1.

Create a new linear dimension in the
right view, using the corner of the
blade cradle and the quadrant snap
point on the end of the handle as snap
points.

Under Representation, select
Reference Dimension.

6.02in ———————

Specify dimension line location

© DIMENSION PROPERTIES

Primary Precision  0.12 v
Alternate Units D

» Tolerance

¥ Representation
Reference Dimen:..

Not To Scale

B X =

== Theoretically Exa..

\ > Inspection
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Lesson 5: Parts List, Balloons, and Title Block

Learning Objectives
1. Inserta Parts List
2. Create Annotative Balloons
3. Populate the Title Block

A parts list is a table that catalogs the components of the design. It itemizes all components in
the drawing, and includes the item number, the quantity, the part number, the description, and the
material.

A balloon identifies a component included in the parts list by labeling it in the drawing.

Insert a Parts List and Add Balloons

A /A
INOTATION v BOM~ OUTPUT ¥

Parts List

Generates a parts list for the design
assodiated to the drawing.

Step 1: — Insert a Parts List

1. Click Parts List and click the very top
right corner to place the Parts List
there (you may have to move some of
your views over a bit, to make room).

The Parts List automatically populates, taking P
information from Model Space.

24



PARTS LIST
ITEM [ QTY [ PART NUMBER DESCRIPTION WATERIAL

1 1_[GRIP1 BACK GRIP RUBBER, NITRILE

2 1_[GRIP2 TOP GRIP RUBBER, NITRILE

3 1 |EFT OUTER CASING STEEL, MILD

4 1 [RIGAT [OUTER CASING STEEL, WILD

5 1 BLADE IDETACHABLE STEEL, CAST

B 1_[BLADE CRADLE SLIDES 1.1 INCHES ABS PLASTIC
B2in
|~ oozin

HAfAE

ANNOTATION ¥ BOM~¥

Balloon

Generates a balloon for a component in a
drawing view.

Step 2: — Create Annotative Balloons

1. Click Balloons in the BOM toolbar.
2. Onthe NE isometric view, select an
edge of a component.

Click to place the balloon.

4. Continue selecting components until
all items in the Parts List are
numbered.

5. When finished, press Enter.

w

Specify balloon location j




About the Parts List

A component's part number and description can be modified in the Properties Panel in the Model
workspace:

© BROWSER 7
4 (b utiityKnife vi © PROPERTES |
b ] Named Views Area 1.369E+04 milimeter"2
[ units: mm Density 0.01 gram / millimetert3
> @ EJ origin Mass 55.18 gram
> @ EJ Joints Physical Material ~ Steel, Mild
> Q@ EJ canvases Volume 7029.71 millmeter*3
>  EJ Sketches World X,Y,Z 0 millimeter, 0 milimeter, 0...
> @ EJ Cconstruction Copy To Cipboard
& Part Number 10772 N
> ight:1
> g g :: 11 Part Name et p
3 Q () erip2:1 = Description Left Casing
> @ (J Bladet
> @ (J BiadeCrade:t )Zq‘ " oK | [ cancel |
P -

If you change the name or properties of a component in the Model workspace, the changes will be
applied to the drawing once you associate the drawing with the saved model (see Associatively Update
the Drawing).

Note: The parts list table is not editable or customizable.

Populate the Title Block

3 © TILE BLOCK PROPERTIES
Approved  J. Goldman

5/20/2015

To populate or edit the contents of the title
block, simply double-click any boundary of the

Checked

PROJECT

title block. Fusion 101

e . Dris: U Fusion 101
The Title Block Properties dialog box opens. Utility Knife = o
Input your text, and click OK when finished. Drawing

5/20/2015|SIZE]  CODE DWG NO
B
SCALE 1:2 [WEIGHT

Note: The title block is not customizable.

OK Cancel
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Lesson 6: Drawing Settings and Preferences

Learning Objectives

1. Modify the global annotation settings for the current drawing
2. Modify the properties of an individual dimension
3. Change the default settings for future drawings

You can modify annotation settings such as annotation font, annotation text height, dimension
precision, and whether or not you want to display dimensions, by accessing Annotation Settings @~ in
the bottom of the drawing area. You can change the sheet size by accessing Sheet Settings. ¥~

Modify the Annotation Settings for the Current Drawing

Step 1: — Access Annotation Settings

1. Click Annotation Settings in the Fi

bottom of the drawing area. hee o
Inches (in) U
Third Angle Projection
Annotation Font > D
Annotation Text Height »
R Linear Dimension Precision B 15|SIZE
Angular Dimension Precision P ] B
aiiotation Unit » SCA

=~
~—

. . DETAIL A
Step 2: — Edit the Annotation Preferences

. SCALE 2:1
1. Change “Display Annotation Unit”

to On if it is not already set that

way. .

2. Change the Angular Dimension ASME @i
L. Inches (in) 012
Precision to 0.1. Third Angle Projection 0123

Annotation Font » 01234
Annotation Text Height p| 012345
Linear Dimension Precision P 0.123456
Angular Dimension Precision |  0.1234567

Display Annotation Unit P| 012345678 OVE
G HECK
s qaQ _ CHECKEL

The annotation settings apply to all dimensions and text in the drawing. However, you can
change the properties of an individual dimension, which overrides any “global” settings you have
changed.

27



Modify the Default Settings

The default settings affect all future drawings.

Step 1: — Access Drawing Preferences

Jeremy Goldman v

Autodesk Account
Preferences

My Profile

1. Click Preferences in the User Profile
drop-down (your name).

Work Offline

PARTS LIST
2. Under General, click Drawing. DESCRIPTION W@ Sign Ot
3ACK GRIP RUBBER; NITRILE
TOP GRIP RUBBER, NITRILE
DUTER CASING STEEL, MILD
. . DUTER CASING STEEL, MILD
Here you will see the default settings that DETACHABLE STEEL CAST
SLIDES 1.1INCHES ABS PLASTIC

apply to any new drawings that you create.

PARTS LIST

ITEM | QTY | PART NUMBER DESCRIPTION
CREL] 1 1_|GRP1 BACKGRIP
. B ==
4 General I Preferences that set defaults of newly created drawings ]
APl
Design Draviing Format [ASME. =
CAM
Drawing Annotation Units [in
Material
G;::;s Sheet Size [B (17in x 11in)
Network Overtide or Restore Format Defaults Below
Data Collection and Use
Uit and Value Displa i ;
aDentits Projecion Angle (THIdAN Cr.ccying this allows editing of the b
Design Text Height [0.12in "
o [
Preview Font |Arial .
Linear Dimension Precision (012
Angular Dimension Precision (0.12 |
Display Units il
|
] i ] »
Restore Defaults Apply
—
PROJECT
Fusion 101
83 [ TIE
in |11mm L .
Utility Knife
Drawing
[APPROVED J. Goldman 5/20/2015[SIZE|  CODE __|DWG NO
B
SCALE 1:2 |WEIGHT

g ajer 8-

Note: The default settings are applied whenever you create a new drawing. Some of the settings can be
modified after you have created a drawing, but settings like Drawing Format, Units, and Projection Angle

cannot be modified once a drawing is created. If you need to switch these, you will have to create a new
drawing.
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Lesson 7: Associatively Update the Drawing

Learning Objectives
1. How to update a drawing so it reflects any changes made to the model

If you make any changes to the model's geometry and then save the model, you can update your
drawing to reflect those changes by clicking “Get Latest” on the toolbar.

If there are saved changes to a model, you will see this message in the bottom right of your screen:

Changes have been made to a referenced
A design

You can update the drawing from the button
in the Application Bar.

And you will see this message if you hover over the versions button:

Drawing is out of date; it's referencing
an older version of the design.

AL
Click to update the drawing to the
N~

latest version.

BOM~ G

Reference: Utility Knife
Version: 17 (v18 exists)

T

18.2°

v

Front View

If you click “Get Latest,” the drawing will update to reflect the new changes.
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IEWS v MODIFY¥  ANNOTATION v BOM¥ q

If any annotations associated with the drawing view geometry get disassociated because of the model
change, badges are displayed on the screen. To delete or manually re-associate these badged
annotations to the view geometry, you can snap to specify the points or select the objects you want the
dimension to get re-associated.
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Lesson 8: Output the Drawing

Learning Objectives
1. Output your Drawing as a PDF or DWG file

When the drawing is complete, you can output the layout as either a PDF or DWG file. Both of
these options creates a copy of the drawing and prompts you to save it locally.

Output the Drawing
Step 1: — Save the drawing

1. Initiate the file menu dropdown and
click the Save button.

2. Enter ‘Utility Knife’ in the Name field.

3. Click OK.

B Output DWG
(2 Output POF X

Step 2: — Output a PDF

1. Initiate Output PDF.

2. Navigate to a desired local location on
your computer.

3. Press Save. 0024in




